Activinspire

User Manual

% HOLLYWOOD

INTERNATIONAL

The ActivClassroom 4, somerean



Introduction 3

Getting Started 6

Text 16
Resources Library 22
Drawing Tools 28
Images 32
Mathematic Tools 41
Presentation Tools 46
Flipchart Techniques 54

e The ActivClassroom s scomervean




Welcome to Activinspire User Manual. In this book, we will introduce you
some of Activinspire’s most important features, helping you to create
excellent ActivBoard lessons. We hope that these tutorials will reveal how

Activinspire can transform your classes, helping your students to learn

more effectively.




In this manual, we focus on Activinspire software. We assume that your

hardware is ready and that Activinspire is installed on your computer.

You can install Activinspire on the computer you use for preparing lessons

as well as the computer you use in class.

1. Using your ActivBoard

Turn on your ActivBoard. The power indicator light which is, in the top-left corner

of your board, should be illuminated when the ActivBoard is turned on.

When both your ActivBoard and your computer are fully started, hold the
ActivPen lightly on the board without pushing in the nib. The cursor on your
ActivBoard should line up with the ActivPen's tip. If it doesn't, you need to
calibrate the board.

2. Calibrating ActivBoard

Hover the tip of your ActivPen over the power indicator light, which is
in the top-left corner of your ActivBoard. Be careful not to press the AcitvPen’s nib.

Wait a few seconds then follow the instructions that appear on the board.




Tips for using the ActivPen

The ActivPen is just like a mouse.

Moving the cursor
Hold the pen nib lightly on the board; don't push in the pen nib.

Move the pen around. The cursor will follow your pen.

Left-click
Tap the pen nib firmly but quickly onto the ActivBoard.

G

X2

Right-click
Hover the pen nib over the ActivBoard, at less than one quarter inch

away from the ActivBoard. Press the barrel button on the side of

&)

the pen.

Click and drag
Click on the object you want to move, hold the pen nib down on
the ActivBoard and then move the pen. The object you have

clicked will move with the pen.

Double-click
Two firm but quick taps with the ActivPen’s nib performs the

same action as a double-click with a mouse.

B
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'Flipchart' is the name we give to an Activlnspire presentation. Like a

traditional paper-based flipchart, an Activinspire flipchart can contain as

many pages as you want. However, unlike a traditional flipchart, you can

incorporate a number of different media forms into your flipcharts

including sound files, videos, animations, interactive activities and web-links.

The only real limit is your imagination!

1. Launching Activinspire

When your computer is fully turned on,

you will see the Activlnspire icon on your display.

Double-click on the Activinspire icon to open the software.

Click OK on any messages until you see Activinspire Dashboard.

f".f' Activinspire Dashboard) =
l\,t// Flipcharts. .. \ / "\ Create a new flipchart
@ Open a flipchart
. Annotate over the Desktop
_ il Open the flipchart 'ActivClassroom Template[1]'

{ ; ExpressPoll

= ﬁ Open the flipchart '111°

8 Promethean Planet = ;

i Import from Powerpoint...
Jec]

Configure... ’] Import from SMART NoteBook...

, Training and Support
Show the dashboard window on startup

Click on ‘Create a new flipchart’ to open a new Flipchart i

then click on ‘Close’ to close the Dashboard.

1

" 4\ Create a new flipchart




2. Main Toolbox

After create a new flipchart, The Main Toolbox is displayed
on the right border of Flipchart page.

Menu bar

[El| B8 Pagetoft [Bestrit

e > Main Toolbox

I

3. Pen Tool

[ To activate the Pen tool, click on it.
You'll see it is highlighted showing that it is active.

Example
Write the word "Welcome'

on the Flipchart page. We IC oMme
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4. Undo Tool and Redo Tool

% Don't worry about making mistakes because most changes made in Activinspire can

be reversed. Click on the Undo tool. This will reverse your last action.

Exampjg e e "

Undo the writing ‘Welcome'
Welcom

Click on it several times. Your previous actions will be reversed in turn.

Q Redo tool will reinstate actions cancelled with the Undo tool.

Click on the Redo tool several times until U\) |
clco

the full text appears on the page again.




5. Pen Width and Pen Color

Choose a different pen width by clicking on
one of the circles below the color palette. Color Palette
Choose a different pen color by clicking on

one of the color in the color palette.

Pen Width

s ~rrr
o : 10

Write ‘To' underneath the word ‘Welcome'

6. Pen Width Selector

To change the width of the pen,
click on the pen width selector and drag
it slightly to the right.

A tool tip will appear telling you the width

of the pen. Pen Width Selector

Example

Write ‘Activinspire!!’ w \ i
with orange pen color and bigger width. 5 0N
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7. Highlighter Tool

l One of the most important presentation tools: the highlighter.

Highlighter can be set in different color and width like a pen.

8 Activinspice, Stusia 5

PP e — —— B roeiors e [93C
°
x

Write over ‘'Welcome' and ‘“To' to

highlight it. We lcome

fo

8. Eraser Tool

l You can also delete lines using the Eraser tool.

You can use the pen width selector to
change the size of the eraser.

Write over the words "Welcome' and L/\ Jsho

‘To' to make it disappear.

Fle B3t Ven Imet Ts 4D | Untted® ® | N - P
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9. Select Tool
k The Select Tool is used to select and manipulate items on the page.
Click on the Select Tool then click and drag on any item to manipulate it.

You can click to select and drag more than one item at the same time.

10. Flipchart Bin

Here's another way to delete items.

If the Flipchart Bin isn't on your Flipchart,
click the Menubar > View > Flipchart Bin

You can delete items by one of this method:
1. Select the Select Tool k click on the item then click on the Flipchart Bin.

2. Select the Select Tool k click on the item then drag and drop into the
Flipchart Bin.

You can recall the deleted item by click on Undo Tool :




11. Saving the Flipchart 00

B meil
Click on the Main Menu button E Fle ¥ | (/) newFipchart cri+N
Select File > Save i i »
view b ﬁ Onen CHiso
Your file will be saved as Flipchart file insert b | 7 openRecent 8
(.ﬂ ipchart) Tools. P @ Close Flipchart Ctrl+w
i |ﬂ Save cl+s
| .
O W B sevess..
| jﬁ_“ e
b ﬁ Publish...
/2 Submit Flipcharts to Promethean Planet
l & Import »
Ei' i ﬁ Print... ctrl+0
@ ﬁ LB settings
Z@ Q o
it

Picture of saved file Flipchart1.

Double-click on saved Flipchart to open it.
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12. Adding Pages to Flipchart

Activinspire is paper-based Flipchart.

It can contain as many pages as you want.

7}
[~ O
b O

You can view/add pages in your Flipchart by
click on ‘Next Page’ or ‘Previous Page’ button
in the Main Toolbox.

Lol
R

l
A

|
I
AL
|

we Next Page
Click to show the next page of your Flipchart.
Or add a new page to Flipchart if no next page is available.

4u  Previous Page

Click to show the previous page of your Flipchart.
Or add a new page in front of the first page of your Flipchart.

-ﬂ](i Acﬁﬁvmassmmm by PROMETHEAN @




13. Page Browser Page Browser

Click on the ‘Page Browser’ button in
Main Toolbox.

=
Ll

Brower is automatically hidden

if your mouse is away from it.

You will now be able to see thumbnails \

of all your pages. !

HE

You can click on page thumbnail to show that page over your screen.

E
C——T

[y § =)




14. Moving Main Toolbox

The ActivClassroom 4, someriean

You can move your Main Toolbox 7
by click and drag on the top of the Main Toolbox. | 500

Click on ‘Toolbox Options' button [E for auto-alignment the Main Toolbox.

o Dock Left  :Align the Main Toolbox to left border i Dock left

e Dock Right :Align the Main Toolbox to right border | v P

e DockTop  :Alignthe Main Toolbox to top border | Lo

lo]
o Dock Bottom : Align the Main Toolbox to bottom border ’
. . Dock bottom
o Floating : Freely move the Main Toolbox
Floating

Flipchart Bin can be moved
by click and drag on the top of the Flipchart Bin.

E I e £t ven Inei s b | hechami® B o iots (s

Select ‘Dock Bottom'
in Toolbox Options.

Hermgt-sopiemmmmm e DX/ 2028,|s8 uc3 "W




With Activinspire, it's easy to create neat, typed text on an ActivBoard.
Once the text is on the page, you can manipulate it in many ways, making

it easy to create professional-looking, flexible lessons which can be repeated
and refined over time.

1. Text Tool

To type text on the page, you just have to place the cursor at where you
want and start typing.
The Text Edit Toolbox will automatically appear.

Example

Type the word ‘working with text’

Fle Edt View Insert Toos He\uJ Untitled ®

pr— -#-1 B I U T AX[]=
3

b
]
I

1wt o
1 =t 3

[
.
il

x]
working with text ©




2. Text Edit Toolbox

The Edit Toolbox will automatically appear when you start typing.

AngsanalUPC ‘ - 47 « 1" 1Ir ’ ) Ly ) I Eed R i
Font Style Font Size |Decrease Size  Bold | Underline | Subscript
Increase Size Italic ~ Superscript
’ = ‘ Color Palette will appear when you click on ‘Font Color’ or
," : U ImimE | ‘Background Color’. You can select

Font Color EE’ESE& Color Picker Tool _# to copy
EEE Z any color on your page.

Background Color

Il

— il
111
P
I}
4+

4
i

£

Align Left | Align Right | Indent Adjustment

—

111
ot
i
-

On-Screen Keyboard | Symbols

Center  Line Spacing Bullets Select All

The ActivC
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3. On-Screen Keyboard

. The On-Screen keyboard is useful if the
computer keyboard is a long way off

or if you want to get students up to
the Board.

To select On-Screen Keyboard click on

e Tool & > More Tools... > On-Screen Keyboard
e Orclick on ‘On-Screen Keyboard’ button in Text Edit Toolbox

You can change On-Screen Keyboard for other languages by

Click on Menu bar > File > Settings.

Fileil Edit View Insert Tools Help | uUntitlec

ULJ Settings... : 4

U/
2
|
~
ol
|
-4

New Flipchart Ctrl+N
New | 4
Open... Ctrl+0

QOpen Recent 4

Close Flipchart Ctrl+W

Save Ctrl+S
Save As...
Summary...

Publish...

Submit Flipcharts to Promethean Planet

Import »

Print... Ctrl+P

Settings...

0=k

Exit




Edit Profiles will appear, select ‘User Input’ and check

‘Use keyboard supplied with operating system’ box. Use keyboard supplied with
Y PP P &Y operating system

’lHAtTheBoard ﬁ u u o @

' ﬁ Layout " ﬁ Commands “ L!_-J User defined buttons L!,] Settings
Learner Response System
Clock Tool Key!
Effects board
Flipchart Objects Use keyboard supplied with O
Language operating system
Online Settings
Spell checker Use keyboard specified by user | C:/Program Files/Activ Softw% E}
Tools 3
User Input il et gk |
P Recordings with text objects
Profile and Resources Automatically show keyboard O
Flipchart when saving files
Multimedia =
Design Mode Recognition Tools
Recognition Timeout 1 —}—
Fill recognised shapes ol
Fil mode [pnother coowr ]
Another colour
HanTINg (eOgON e (Unted kingdom) [
S | £3|

Restore File Associations

Click On-Screen Keyboard . again, On-Screen Keyboard with your Computer
operating system will appear.

Us-lerzas DEYPPATE: ETE

File Keyboard Settings Help

esc F1|F2 F3| F4 F5|F6  F7 | F8 F9 |[F10/F11 F12| psc brk
2 112|345 |6|7]8)19]0]|- = bksp |ins | hm pup 71=1-
tab q/ w e | r |ty luli ol p I 1 kY del lendipdn) 7 | 8 | 9
alsldlelaln]ilx]o]:]"] emt 4|s]s]”’
z|x|lc]lv|b|n|im]|. . 7 112)]3
> ' 0 ) ent
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4. Editing Text

To edit the text, click on Select Tool [§\ double-click the text and Text Edit

Toolbox will appear.

5. Recognition Tool

The Recognition Tool takes your handwriting and turns it into typed text.

Click on Tool &' and select Handwriting Recognition B Desioo Annotate Crl4hift+A
B¢ Deskioo Todis F6
Aﬁ Handwriting Recognition Ctrl+Shift+H 1? Dusl User F4
J ExpressPol F3
Write a word, wait a couple of seconds then your 7 = A
handwriting will be converted into typed text. 4 oo Cul+H
l Eraser Ctrl+E
=X Cul+F
- = & g Cerl+shft+11

= ;l"‘, Handwriting Recognition Ctrl+Shift+H
& B shape recogniton
2
H" EE Revealer Crl+R
% Spotight
el Camera

| ff  weths Tools

.
E1]
.

v | v w w

More Tools...

WMQQQ\WU
A AN AN
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Example

Write the word ‘school’ and wait a second, it is converted into typed text.

lschool [

S( L“OO =) school

\school 7"

If the text has not been recognized correctly,
{ School
| shoot

alternative from the options, if available. Shoot
|SCLOOI

click on the ‘Alternatives’ button. Select the correct

Shape Recognition Tool like Handwriting Recognition Tool but will convert into
shape instead of word.

? Shape Recognition

Example
Converting the circular shape.
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The Resource Library contains a huge range of images and other resources
for you to use in your flipcharts. It's also the place to store any of your own

resources you want to save for future use.

Resource Browser B O

Starting Resource Browser *nfm ZE e

1 n fb :umen:sandSemﬁgsfreat?{] E]
Click ‘Resource Browser’ in Main Toolbox. [ OE @

5‘ Browser Window will show up the Resources. - 3‘

@ [ Shared ACTIVites L

There are two main sections in the [ Shared Amnotations 1
@[] Shared Assessments =

@ [ Shared Badugrounds

@ [ Shared Collections

Resource Library:

My Resources @ (L) Shared Fipchart Pages
x : . B hared F .
This area lets you to organize and store e i el v
e ] > 10

your OWn resources. —
Shared Resources
n Contain all the resources that were

installed with Activinspire.




2. Shared Resources

Shared Resources contain three main sections:

() Resource Browser B ©
EERC %€
x n @ l:uments and Setﬁngs/‘l’eam1 [2]

. Search: Insert keyword here then click | 9 B @
[A]

‘Start Search’ to start searching.

& [) Shared Resources
- () Shared ACTIvities
- (2] Shared Annotations

(|

&5 &

List of all folders in Shared Resources.

- u lelGl I:d 4 1<y |t>
@~ () Shared Backgrounds
- [L) Shared Collections
j [L] Art &design
. @[ Citizenship

Displayed contents in thumbnail of

selected folder.
Argent.as2

This example shows contents in

Shared Collection > Art & Design

Astruc.as2
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3. Contents in Shared Resources

Shared Resources contain a lot of images, backgrounds, grids, flash files,

sounds and many sample Flipcharts.

Shared Activities : Contain flash files for using as activities
Shared Annotations : Contain image annotations

Shared Backgrounds : Contain backgrounds

Shared Collections : Contain images sorted by subject field
Shared Flipchart Pages : Contain sample Flipchart pages
Shared Flipcharts : Contain sample Flipcharts

Shared Grids : Contain grids

Shared Images : Contain general images

Shared Shapes : Contain mathematical shapes

Shared Sounds : Contain sound clips




4. Using Resources

Using image Resources

Click and drag one of the images from
the thumbnails panel onto the page.

Example

Image from Shared Collection.

Using background and grid resources e
2 -Qwummmg
= > Mg

Click and drag it onto the page.
It will appear behind anything else on

the page.

Example
Background from Shared Background.

.
Using Sound resources SrEE T
L 28 % e s (]
= oL e
® ) Swedlnes [~

Click on the speaker icon to play B

sound from resource.
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5. Rubber Stamp

‘ Currently, you are using the Drag and Drop way of adding images to the page.
Rubber Stamp adding images by copy and paste to the page.

To use Rubber Stamp:

1. Click on selected image.

2. Click on ‘Rubber Stamp' button.

3. Move your cursor to page; a translucent image will appear.
4. Click to paste the image.

Example

Translucent guitar
in Shared Images.

Click to paste guitar image.




6. Adding Resource

You can save image on you page to your Shared Resources or My Resources.

Click and drag image to Resource Browser.

Image will be saved to selected folder in the Resource Browser.

Example
Click image on the page
and drag to Shared Resources.

Right-click the image in Resource Library.

e Insert into Flipchart
Add image to page.

o Rename Resource File

Rename image from Resource.
e Delete from Library Insert into Flipchart

Remove image from Resource.

Rename Resource File

w Delete from Library
L

-I_he ACtiVClaSSI‘Oom by PROMETHEAN @



In this tutorial, we will show the range of options available for drawing lines
and shapes. While doing this, we will show you some options which increase

the colors you can use in your flipcharts.

1. Shape Tool

B Click on ‘Shape Tool' icon in Main. Toolbox EEI‘l 5%! AN
Shape toolbar will appear on the right of the page. ..‘\ !. e
This contains a range of tools for drawing lines | \l : 2
and shapes. | | v

To draw shape: X e
1. Select shape. < < 2
2. Select border color in color V V
= o®
palette on Main Toolbox. — = A
3. Select fill color in Shape Tool. 5—91 E E El
4. Click and drag to draw shape |
on the page. ° i -.{ © ®
A A
o o N
0 ol
O ® |
* * -
= B\
Click to show all available shapes. Q = N
0 e
& + S
¥ =




2. Connector

I\
. . . N
& Connector is used to draw a connected line between two shapes.
N
Click on the Connector in Main Toolbox N
d
To use Connector:
Prepare two shapes before draw the connected line. N
1. Select the line.
2. Click on the first shape. \
3. Click on the second shape. _I\_
4. Connected line will be made to link between two shapes. -
\2
\2
EXZJ]JPJ_G W oot o '?ﬂ
]
Prepare two shapes. s
53
/i‘
&Y
e
/\_/ o
ae
fo 1}
u
Click and link two shapes together.
e =con o =g
ESt Vew Teet Toss MeD | umtkied® & -éx SetFe _ 5 oo | untted® & I-E-Tnm -<
i P 3 i = 3
| I NI 2 |k
| b b g N
i LY b i LES b
22 ! e 0
iL a2z 3 il a2z 3
| E_,’ 8 | ‘El \_
/—\—/ & N & v
dc 4c
ae ae
fo ] fo ]
1 1




3. Fill Tool

& Fill Tool is used to fill or replace color of any shape.

To use Fill Tool:
1. Click on Fill Tool.

2. Select color on color palette.

3. Click on area inside shape to fill the col :

Example

2 i

Draw a circle shape filled with red color.

F+0a8%00OODROEOOCN Y —

Click on Fill Tool, select yellow color.

Click on red area;

replace red color with yellow color.

SN

S LR i
o EmN e R

o

LT




4. Adjusting color palette

File (EditJ View Insert Tools Help Untitled * =/

Design Mode F2
You can adjust the available colors in o oz
color palette. < :
Select Esc
Select Menu bar > Edit > Profile Y sccn i
E Page Background...
= o Cti4shift+G
‘ ;z Profiles... Ctrl+3 - P S
g Reset Page
«? Cut Ctrl+x
A cony ctisC
Paste Ctrl+v
;_J Duplicate ctrl+D
Delete Del
Edit Profiles will appear, At ‘Main Toolbox’, :::::m :
select number of available colors. [l QuestononCurentpoge...  Cuisnitag
5,3 Student Database. ..
You can choose between 8, 16 and 24 colors. Device Regstatin...
|If Profiles... Ctrl+]
, Design Mode Settings...

24 Colouirs }
-8 Colours

| 16 Colours
| 24 Colours

i‘_r-'. At The Board i‘j ﬂ ﬂ X ’g

NN

out

ﬁf Commands H lé] User defined buttons “ L_Q_J Sem‘ngs)

Icon size

Main toolbox |Dock right Pinned [] Rolled up Rolled in
Dual toolbox jDock left Pinned

Browsers {Ed( left [ Pinned Visible

Menubar ‘lbock top Visible

Document tabs {Dock top Visible

Show fiipchart bin
[] show fullscreen

Restore File Associations
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Used with the internet and other sources of images, Activinspire opens up
many possibilities, making your classes more colorful and more in tune with
your students’ lives. Using the techniques described in this tutorial, you can

take any image you want and place it in your Flipcharts.

1. Adjusting image size
Every image in your Flipchart can be resized.

Click on Select Tool ‘k

then click on image,

image edit toolbox will show up.

e Click and drag on '\_\’
To resize the image by each side.
e Click and drag on B

To resize the whole image but not proportions of the text.

)

Q

[ N




2. Image Edit Toolbox

When you click on image, Image Edit Toolbox will appear.

B 2 () ) e ) ) e ey )

Details of each icon will be explained in the following topics.

3. Freely Move Object

&; Click Select Tool k to move items around the page.

4. Rotate Object

LL Click and drag to rotate the image.

5. Object Edit Menu

| Show image edit options.  [£] [l [l 01 Tl o]

Bl
/) 7] PropertyBrowser  F3
E é Action Browser F10
i
| ‘
| g
& )
| ? Cut Ctrl+X
; H Copy Ctrl+C
[ LL Paste Ctrl+v
4 | Duplicate Ctrl+D
X Delete Del
Transform >
Reorder »
\“l "
.
g o




6. Translucency Slider

L!J Click and slide to translucent image.
More slide to left side,

more translucent the image.

Example

Translucent image.

Q-
:
e/

2

7. Grouping

™= . T . .
M Currently, all the images appear as individual items. You may want them all to exist
as one item, so that it is easier to move and manipulate them in the future.

To do this, we should group the images.

To group images.
1. Click and drag all images.
2. Click on Grouped icon into highlight E] to group images.

@ T.he ACtiVCIaSSFOOm by PROMETHEAN




8. Stacking

The last image you add to the page appears

on the top of other images.

This example, three images: dog, fox and pig
we drag in dog first followed by fox and pig.

You can change the order of these images.

(el | Bring Forward

= | .
Upper one order to selected image.

(] Send Backward

=

Lower one order to selected image.

Example

Click on dog image and select
‘Bring Forward’, dog will be upper
than fox but still below than pig.

Click on dog image and select
‘Bring Forward' again, dog will be
upper than fox and pig.

The ActivClassroom s scomervean




9. Increase Object Size, Decrease Object Size

L&x Increase Object Size

Click to increase selected image by 10%.

L'_l Decrease Object Size
Click to decrease selected image by 10%.

10. Clear Tool

$é It is used for clearing whatever you want to delete from page.

When you click on Clear Tool, a menu will appear asking

you what you want to delete.

,’}z Clear annotations | Clear all pen lines and highlight lines.
Eé Clear Objects Clear all images and texts.
; ﬁn& Clear Grid Clear grid from page.
{ % Clear Background ~ Clear background from page.

‘iz Clear Page Clear everything from the page.

You can click the Undo Tool ‘:

to restore your last action.

i =
o
A ©

t P
fs)(y. B [%

-

g N ey
o W W =

o [0 T I |

3

e L NN 4
AN EORR

Lot ]
P
Q.

- I"(‘é Clear Annotations

a
- Eé Clear Objects

m& Clear Grid
% Clear Background

» 1 _‘é Clear Page
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@ esion annotste Ctrl4Shift+A

11. Camera Tool y i

é ExpressPoll F3

i You can capture some of your images A~ B
l Highlighter Ctrl+H

' Eraser Ctri+E
EJ e w cri+F

. q @ Magic Ink Ctrl+Shift+M

s A HandwritngRecogniton  Cirl+shift+

> J ‘y Shape Recognition

by using camera tool.

Click on Tool ﬁ' and select Camera

“ camera ’ Eggi B Revealer Ctrl+R
Eﬁa‘ % Spotlight »
i
E |Iﬁ Camera » E} Area Snapshot Ctrl+Shift+K
Tie .l @ Maths Tools 4 % Point to Point Snapshot

j More Tools... » E) Freehand Snapshot
% Window Snapshot
ﬁ‘ Fullscreen Snapshot

To use Camera Tool: <5
1. Select snapshot type

o Area Snapshot Ctrl+Shift+K
| P

Rectangle area snapshot.

x|
Snapshot to Fosition
7 CurrentPage Left |was B
oo |
& NewPage
T Wicth
[[] ciobosrd Height [aro B3]

L treares

n Shared Resources

° % Point to Point Snapshot

Shape area snapshot.

Snapshot to

" CurrentPage

+ NewPage
[ cioboara
L R

n Shared Resources

ol
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) w Freehand Snapshot

Freehand area snapshet.

Snapshot to

S CurrentPage

& NewPage

[] cioboara ‘
x My Resources :

u Shared Resources

b % \Window Snapshot

Make a snapshot from Window browser.

° ﬁ'ﬁ Fullscreen Snapshot

Fullscreen snapshot.

2. Click and drag the area of snapshot Snapshot to
then select location to place snapshot. % oiipace
- ‘ 1 ]
b Current Page (#| NewPage

Place snapshot to current page.

“ Shared Resources




) & NewPage

Place snapshot to new page.

° D Clipboard

Save snapshot to Clipboard.

l My Resources

Save snapshot to My Resources.

° u Shared Resources

Save snapshot to Shared Resources.

Example

Take snapshot on rabbit image Area Snapshot
and select snapshot to Current Page.

Position

" CurrentPage

teft [sao [
Top :rnaa E}

Width |ean B

D Clipboard
& My Resources

n Shared Resources

Height ‘ @m0 H




12. Import image from your computer to Flipchart

To import image from your computer to Flipchart
just drag and drop image to your page, image will be automatically imported.

¢ [X]]
Fle Edt Vew Inset Toos Help | Untitled® ® | Page20f3 [Bestrit [ <
— .

tes Tools Help »
§ | Osech [ roders | [T~ | (KR Foersyme

e\SolarSystem

:

Drag and drop

image to import to

your Flipchart

180px-790106-0203 ...

MR o

You can adjust, resize or edit the imported image like image from resources.

You can also import sound, music, video, flash files or any other files by this method.




Activinspire contains a number of tools to help you working with numbers.
We've been very broad in our definition of number tools; however, the tools

in this tutorial can be useful for teaching many subjects.

1. Getting started with Maths Tools

CIiCk TOOI ﬁ in Main TOOIbOX - Desktop Annotate Ctrl+Shift+A
3358 r
Select Maths Tools ; ik =
| Dual User F4
[ é ExpressPoll F3
/ Pen Ctrl+shift+
@ Maﬂ‘ls TOOIS } l Highlighter Crl+H
@ == cuis
E] 2 A Ctrl+F
WEZ veocrn Ctri4shift+4
] . . .
Here's a list of six mathematic tools PR e —————
. . . J v Shape Recognition
in ACtIVI nsplre' i’ié B Revesler Ctrl+R
Eg\i % Spotiight »
DE el camera »
y‘ RuIer . !@@7 Maths Tools » ,” Ruler
j_' More Tools... P | @ Protractor
fan Protractor L3 M compass
' / l ¥ xvorign
/ § Compass o5 @B oceroler
! B j’ fg Calcuator
@ XY Origin 5 E
e
@ Dice Roller - ?
@ Calculator
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2. Ruler Tool

& Click on the Ruler Tool, a ruler appears on the Flipchart.

"lY'U"V}'YT"T"Y}"T'TTY'Tl"l"”"“'”"l" T'H"IT'}T"l"lV'T"lW'TT"V"Tr""H'YI"TT'U"]"TI"l"[!"l"”'{l"lf'T
| | | | |

\i\;lll.‘l\‘li\:ll.;Elll!“lllﬂ\II‘;11;\.\

To use Ruler:

e Move ruler by click and drag in the -

middle of ruler.

e Click and drag on the side of e
the ruler to resize it. “‘_’ = E=

B bbbl bbbl all bl dal

o Click and drag on the scale to

rotate the ruler. | #

e Select Pen Tool ! click and drag on ruler

to draw a straight line.

[ [
L,;-i,i-i.g,l.i.l-I-L‘h‘z,L-L.l sl be bbbl babubadadulyl ] Lolala ila bl

To delete ruler, drag and drop ruler into Flipchart Bin.




3. Protractor Tool

s Click on the Protractor Tool,

a protractor will appear on the page.

As with the ruler, the protractor has several

regions which do different things.

| B R RN
L %

To use Protractor:

o Click and drag center area to

move the protractor.

e Click and drag border area to
resize the protractor. “—>

e Click and drag inside area of protractor

to rotate the protractor.

e Select Pen Tool ! click and drag on the protractor

to draw a curve.




4. Compass Tool

/.ﬁ Click on the Compass Tool,

a compass will appear on the page.

To use Compass:

e Click and drag on the top of compass

or the point arm to move the compass.

o Click and drag on the head of compass

to resize the compass.

e Click on the pen holder to open and

close the compass points.

e Select Pen Tool ! click and

drag on the pen to draw the circle.

To delete compass, drag and drop compass into Flipchart Bin.




5. XY Origin Tool

@ XY Origin Tool is the page's center of rotation.

Everything will now rotate around this point.

e,
. , o .
Click on the ‘XY Origin’ button, an icon appears on the page. A
When rotate object,
o'.‘l ,'.‘.
it will rotate around XY Origin point. 57, L

Click and drag XY Origin point to

move it.

6. Dice Tool

m It is used to generate a random value of

dice rolling. Dice Tl

Click on ‘Dice Tool button to show the
Dice roller box.

© ¢ &

. Number Of dice 13 u Number of dice |3 L;] Speed: ~ = Ji [ Rall ][Output tthpchart]

Number of dice you want to roll.

o Speed: - ‘ j ‘ Speed of rolling dice.

Generate new value.
|0utput to Flipchartl Add the dice total to page.




Activinspire contains many tools which help you to make your Flipcharts

more interesting and interactive when you are teaching your students.

In this tutorial, we will show you some of Activinspire’s presentation tools,

demonstrating how you could use these tools to give focus and pace to your lessons.

1. Page Zoom Tool | |
| View | Insert Tools Help | Untitle:

O\ The Page Zoom Tool can be used to magnify | g= switch Profie

parts of your page. :) \: Fullscreen F5
Click View > Page Zoom Flipcharts »
wmp NextPage PaDown
q Page Zoom Ctrl+Shift+2 =
g
To use Page Zoom: O\ Page Zoom Ctrl+Shift+Z "
. v | Browsers Ctrl+B
e Hold left-click on the page
for zoom in. v | Menubar
e Hold right-click on the page | v | Decument tabs
for zoom out. v | Flipchart bin
e Double-click on the page Dadboad F11
to return to the page's ,
o Pag A
original size. 3
l’_‘)"'? Customise... Ctrl+U
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2. Revealer Tool

. Desktop Annotate Ctrl+Shift+A
o s B¢ Deskiop Tools F6
mm Click on Tool ") select Revealer Tool. M oo =
{ ;? ExpressPoll F3
Revealer trl+R # ren Ctrl4shift+p
“ i 7 1 Highlighter Ctrl+H
SR @ == Crl4E
Your page should become blank. D& w e
. ‘/ Magic Ink Ctrl+Shift+M
- - -\f Handwriting Recognition  Ctrl-+Shift+H
! Ly Shape Recogrition
.D b Revealer Ctrl+R
DEP \\' Spotlight >
E].‘[ @ camera >
s o Maths Tools »
J et >

VI =Ll

NQ T
v BN P Ny e

As you move the cursor around the page you'll see that

it is shaped like a pull-tag.

Click towards the top of the page and drag down.
The blank area will be pulled away to show the Flipchart page.

Tl LRI N
e |




3. Spotlight Tool

* Click on Tool 3{ select the Spotlight Tool then select Circular Spotlight.

\\\ Spotlight 4

The page should become black,
except for one circle showing the Flipchart beneath.

To use Spotlight:

1. Choose Spotlight styles.
2. Click and drag blue border to
increase or decrease the size of the spotlight.
3. Click and drag any point of the black area to
move the spotlight.

Here is the list of spotlight styles:

q’ Circular Spotlight Ctrl+5hift+0 Q‘ Square Spotlight

Q‘ Solid Circular Spotlight Q‘ Solid Square Spotlight




4. Clock

@. Click on Tool ﬁ > More Tools... > Clock Tool.

‘@ Clock

Ctrl+Shift+U

Clock appears on Flipchart page.

Clock’s option:

@ Show analog clock.

3
Q
@ Pause the clock’s display.
®

@ Count up stopwatch.

Show digital clock with date.
Show both analog and digital clock.

......

~

22:20:28

Count down stopwatch.

L 26/9/2552 =

O=m e OO

When select Count down or Count up,

the Clock Counter box appears on the screen.

Set count time.

The ActivClassroom 4, somerean @

Count down from:
| Lovioooo B [Repeat

After timeout, play the following sound:

iNo Sound @—E—

After timeout, perform the following action:

!Do Nothing ﬁf—
o

—— Set sound to play when time up.

—— Set action when time up.




5. Tickertape Tool

‘ = This tool lets you create the scroll text across your page.

Click Tool ﬁ > More Tools... > Tickertape
‘!’ Tickertape... Ctrl+Shift+T

The Tickertape Definer Box will appear on the screen.

— t here
gActivInspire Tickertape “ oo Type your tex
then press OK.
Drop shadow ]o E Colour _
Background iScreen @\ Colour |
Position iTop @
[ Sovtoeme ]

Tickertape Speed Box

You can adjust scrolling speed, pause text

l__.’
E
B

or edit Tickertape here.

To remove Tickertape, close the Tickertape Speed Box.

Example

An Activinspire Tickertape.




6. Screen Recorder
vl You can record your teaching or presentation as video file for future use.

Click on Tool ﬁ > More Tools... > Screen Recorder

bg Screen Recorder »

To use Screen Recorder:

1. Select option for recording

™ "’% Fullscreen Recorder

° g Area Screen Recorder ‘

2. Recorder Controller Box will appear on the page.

Click on red-circle button to start,
A new window will show up to let you save your video file.

Recorderdale

Save in: r@Desktop .:J & & % B

@ {3My Documents
‘ ¥ My Computer
My Recent ‘aMy Netwaork Places
Documents = 1nepire Install

@ () Inspire Manual

My Documents

My Computer

-

Save I
Cancel
Z

My Network  File name: IE
Places
Save as type: lAVl

Lel Lo
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3. Recording will start immediately after you save the video files,
you will notice blinking between red-circle and blue-circle.

(= X ||

m|x |||-||f

Every action on the page will be recorded to the video file.
4. To stop recording, press the stop button |:
Wait a moment to create your video file.

5. To view your video file, click the play button L]

Your voice can be recorded, just connect microphone to your computer.




7. Desktop Annotation

i Every tool of Activinspire can be used on Desktop or on your computer screen.
Click Desktop Annotation i in Main Toolbox.
Your desktop will show up with Main Toolbox and Browser.

Now you can use Activlnspire tools on your desktop.

Click on i again to resume to your current Flipchart. @ @

0P
"

Example

Use Pen Tool on the Desktop and write 'Desktop Annotation’

AM\OT“‘\'Aon

Ll
sl ALY o/ e N N

-I-he ACtiVClaSSI‘Oom by PROMETHEAN




Last section of this manual will introduce how to create interesting
Flipcharts by using Activinspire tools. All of these techniques can be used

in every subject area.
1. Hiding Images
This technique introduces you how to hide images below a large image.

In the example below, we want to hide hen and chick images under barn image.

Fie Edt View Insert Tools Help | Untitled* ® DesktopFlpchart= | Page 10f 1 |BestFit
J

@ T.he ACtiVCIaSSFOOm by PROMETHEAN




Step 1 Right-click on barn image,

. Bring to Front Ctri+Shift+F
Select Reorder > Bring to Front W e :

In this step, we align barn image in front of hen and chick images.

PACHivInSpire S Stdio

Fle Edit View Insert Tools Help | untitled* ® DesktopFlpchart* & ‘ BB Pace 10f1 [Bestrit

Q ~

i PropertyBrowser  F9

6 Action Browser F10

L@ mnsertinktofie...

,'? cut Ctrl+x
A cony ctrl+C
0, peste carisv
4| Dupicate ctrl+D
X Delete

Transform » n

0 , Wy BingtoFront  Ciri4shiftsF

) sl £) oo Culsshift+L | A BrngFornard  Cul+Shiftsy
L . Q) SendtoBack  Chi4shiftss
o ridden crisshift+l | (K sendBadward  Culsshiftsw
S oeoscony Cul+shift+] | ® 1m0 Layer i

=
= ToMiddle Layer
~

To Bottom Layer

Step 2 Right-click on barn image again, ﬂ Locked Ctrl+Shift+.
Select Locked.
Locked image won't move when we drag it.

Fle Edit View Insert Tools Help | untitled* ® DesktopFlipchart* & ‘ B rPageiofi [BestFit

| PropertyBrowser  F9
i

‘ Action Browser F10

L Insertinkto fle...

cut

Copy

Paste

Duplicate

Delete

Transform »

Reorder »

Ctrl+Shift-+L

| Locked

Hidden

Drag a Copy Ctrl+Shift+)




Step 3 Click on Select Tool [k
Then click and drag hen and chick images into barn image.

E[B]X]

* ® DesktopFlpchart™ @ Page 10f1 [Bestrit [ 3%

Now you can freely move hen and chick images and hide them under barn image.

Hint 1. You need to remember the position of hidden images.
2. The hidden images must be smaller than the cover image.
In this example, barn image must be larger than hen and chick
images.

3. You can hide text by the same method.

Application  Use this technique to recall concentration of students, create
interesting lessons, games or exercises.
To hide vocabularies behind the box; hide name of each country
behind map; create story like hide man behind house.




2. Color-Question

With this technique, we combine color and dragging techniques to make your
question more interesting.

Example

In sample Flipchart below, screen of red area contains the words:
“15420="and ‘What is it? Both of them are questions.

When we click and drag these words to blue screen area, these will change into

‘35" and ‘This is a book’. There are the answers of questions.

In this example, we have two sets of question and answer: 15+20=35 and

What is it? — It is a book

We use color in this technique.
We group question and answer together

then fill question and answer with colors of two backgrounds alternately.




Step 1 Click and drag square images from Resources.

Shared Resources > Shared Shapes > Square

Activinspire = SHidio

Fle Edt View Insert Tools Help | untitled* ® DesktopFipchart™ & ‘ B Page1of1 [BestFit

x u @ fuments and Settngs/Team| [...]
10 E @

© [ Shared Shapes [EE]
- [ Amows
(L Crcles and Elipses
(&3 Miscellaneous
() Pythagoras
- [ Quacrlateral
(5 Reguler

- [ Squares and Rectangles
N 5 —— i ]
i A
L &

rectangle.a02

|

Square.a02
[~

[~ ]

V]
<]

=

]

Step 2 Select Fill Tool & Fill each square image with color.
In this example, we fill red and blue to each one.

Activinspire = SHidio

Fie Edt View Insert Tods Heb | untitled* ® | DesktopFipchart™ [Bl| B8 Pecetof1 [pestrt  [g 3¢

—I—he ACtiVCIaSsroom by PROMETHEAN




Step 3 Type text of both questions and answers to the page.

Make sure questions and answers are separate text.

WAGHivInspire

File Edit View Insert Tools Help | untitled* &

What is it? It 1s a book.
15+20=

Step 4 Click Select Tool &‘ Click and drag to match questions and

answers, position questions to be upper than answers.

Fle Edt View Insert Tooks Help | Untitled * ® [El| BA Page10f1 [Bestrit
| (BestFit &4

What is it?
It 1s a book.

15+20=
35

_I—he ACtiVCIaSSFOOm by PROMETHEAN



Steps Select Fill Tool & fill questions and answers with colors of the two

squares alternately.
Example Fill each question with blue color and

fill each answer with red color.

e Edt View Insert Toos Help | untitled* ® [E| B¥ Poge 1of 1 [sestr

[ ]
(]

What is 1t? ;1{
It 1s a book. el
15+20= =

2

Step 6 Group each set of question and answer together, click and drag to
cover both of them then click group button @ to become highlight.

Fie Edt Vew Insert Tools Help | untitled* ®

B@DDE@BDBE@

What 1s 1t?
O[t is a book. |
@ ® 154+20=




Step 7 Increase each square to half of the screen.

[ @ctiviispirer sidio L =]X]
Fie Edit Y nsert Tools Help | untitled * ® @ Page10f 1 [BestFit [ %

Step8  Right-click on red rectangle and select Locked ) lodked S

then right-click on blue rectangle and select Locked.

F:\ Activinspire.- Stisdio, =] d‘a]
w Insert Tools Help | Untitled* ® \ Page 10f 1 |BestFit B ><
chylnspire - Studio, £ PR N P TR 00 00 MR Fm ;_i
e ) Untitled * @ S5 roperty Browser -J B receiofn [estre [ [ @
é Action Browser L @ o
=

L mnsertink tofie..

? Cut
A copy

0, este

Duplicate

Fie Edit

X Delete
Transform »
Reorder >
b ]
Hidden Crl+shift+

‘? Drag 2 Capy Ctrl+shift+)




Stepg Finally, set positions of question-answer sets as you like.

£ SHIGID) J\'J"E

iew Insert Tools Help | Untitled * ® EN Page 1of 1 [BestFit [ %

Hint 1. Make sure to group question and answer together.

2. You can apply this technique with images.

Application  Use it to make question more interesting. This technique can be
used in every subject field.




3. Magic Ink

Magic Ink Tool is used to create a fantastic Flipchart.
Magic Ink works like Eraser Tool, click and drag to erase Pen line or Highlight line,
and its width can be adjusted. Instead of permanent delete, Magic Ink will

translucent line and reveal whatever behind the line.

- Desktop Annotate Ctrl+Shift+A
q Desktop Tools F&
. Dual User F4
To select Magic Ink: ﬂ
\é ExpressPoll F3
! Pen Ctrl+Shift+P
Click Tool ﬁ in Main Toolbox ' vioighier Biie
% l;f‘; l Eraser Ctrl+E

Select Magic Ink @ . q & Fil Ctri+F

S !l @ Magic Ink Ctrl+Shift+M
@ Magic Ink Ctrl+5hift+M i Aj Handwriting Recognition Ctrl+Shift+H
.EDE % Shape Recognition
Revealer Ctrl+R
s Q
| Spotlight »
| [
W sl coners '
- e 9 .
j—; @ Maths Tools >

More Tools... >
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Magic Ink Example:

1. Type word ‘Hidden' on the page.

Hidden

2. Select Pen Tool .;/ in Main Toolbox,

HE =
THEEE
Select blue color on color palette m |7
W
and select Pen Width of 86. =-|:|-

3. Draw blue line over the word.

4. Select Magic Ink, click and drag on blue line.

The word ‘Hidden” will reveal.




You've finished Activinspire Foundation Skills!

In this manual we have introduced you some of the most important features

of Activlnspire. We have shown you the software's principal toolboxes and

we have demonstrated some of the tools you may find most useful in your lessons.




Explore our Help file for many more training ideas or click to learn the endless idea

from Promethean’s websites.

Promethean Learning

For more training ideas, visit Promethean'’s training website:

www.PrometheanLearning.com

Promethean Planet

Promethean Planet is a free, online community designed with one goal
— supporting teachers.

www.PrometheanPlanet.com

Education Technology Division

Hollywood International Ltd.
501/4-8 Phetburi Road, Rajtaywee, Bangkok 10400 Thailand

Tel. (02)653-8555, 653-8255 (30 Lines) Ext. 757,758, 759

Fax. (662)653-9798
Email: edtech@hollywood.co.th

Homepage: http://www.Hollywood.co.th




